
ByHand(tm) Help System
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Please see Limited Warranty and License Agreement. 

The ByHand(tm) editor is a completely new concept in handwriting editing.    It provides true 
WYSIWYG ("what you see is what you get") editing of printed or joined cursive characters 
within normal editing windows.    Type your text using a keyboard and see it immediately as 
smoothly joined cursive letters!    Cut and paste, insert, delete, highlight, and scroll just as 
you would in an ordinary editor.      You can paste pieces of handwritten documents into other
graphics applications to use as logos, banners, or artwork.    You can use other applications 
to generate text and paste the text into the ByHand(tm) editor to convert it to handwriting 
(try this with your mail-merged invitation list!).

You can create your own personally handwritten scripts, or you can use one of the supplied 
professional calligraphic-style scripts.    You can do things that no font can do: letters can 
over- or under-line whole words, or circle the entire page if you wish.    Letters can overlap.    
You can use flourishes to stylize your letters.    You can print the same document in different 
handwriting styles, or with different simulated pen types (ballpoint, calligraphic, or felt-tip).    
You can simulate "real" pens using messy ink or uneven left margins and text baselines.

Note for ShareWare Distributions
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For information on how to use Help, press F1 or select Using Help from the Help menu.



Overview of the ByHand Program

Please see Limited Warranty and License Agreement.

What is it?

The ByHand (tm) program is a WYSIWYG (what you see is what you get) editor very much 
like the usual wordprocessing editors you are used to using.    The only difference is that 
instead of using printed characters or fonts, it uses your own handwriting.    It will 
automatically make smooth joins between script letters and adjust line spacing to 
accommodate larger or smaller characters.    All the usual commands are present for opening
and saving files, cutting and pasting to the clipboard, changing or moving windows, and 
searching for words within documents (see the Contents for a list of all commands).    (Click 
on the highlighted words below for more information about each command.)

How do I start?

To start using ByHand, just start typing!    You can use the arrow keys or the mouse to move 
around the screen.    Use backspace or delete to correct errors.    Lines wrap automatically to 
fit the margins, and hitting Enter or Return starts a new paragraph.      If typing is slow on 
your computer, click the speed-editing button (the race-car picture on the top menu bar) to 
make things go faster by not showing all the letter details.

How do I handle documents?

To save your work, choose Save from the File menu.    To retrieve documents you have saved,
choose Open.    You can print (or choose a printer) and exit from the program.    You can find 
words within your document, and you can cut, copy, and paste words or groups of words by 
clicking and dragging over the selected region of your document, and then choosing the 
appropriate command from the edit menu.

How do I format documents?

You can change the letter size, pen type, and pen thickness using the Character command 
on the format menu.    You can change the linespacing using the Paragraph command, and 
you can set the margins and ink types using the Page command.    You can also change ink 
color using the Pen Color command.

How do I change the handwriting?

The ByHand (tm) program comes with several different scripts that you can use.    You can 
only use one script at a time, however.    To change the current script, choose a script from 
the Script menu. You can enter your own handwriting using a mouse, pen tablet, or any 
other input device that can act like a mouse under your window system.    To do this, start a 
new script and then modify it as needed.    The procedure for entering new character shapes 
involves 3 steps that allow you to enter the character, determine where characters begin 
and end, and specify what letter each character corresponds to.    When you are done you 
must Save your script on disk (this is not the same as saving the document, since the script 
may be used by many documents).

How do I buy the program?

If you received a shareware copy of the ByHand (tm) program, then you will see copyright 
notices printed at the top of your documents, and you will not be able to use the security 
features to protect your own handwriting from unauthorized use.    To see how to buy a fully 



working copy of the program, click here.



Sagittal Software Company

Sagittal Software Company is a small for-profit software engineering company located in 
Brookline, Massachusetts.    We specialize in software for handwriting generation and 
automated calligraphy.

Sagittal Software Company
258 Harvard Street, Suite 301
Brookline, MA 02146, USA

Information: http://www.sagittal.com, or send mail to info@sagittal.com
Technical Support:    support@sagittal.com
Sales: sales@sagittal.com



ShareWare Distribution

The ByHand(tm) program is being distributed on a trial-only basis as "Shareware".    The 
purpose of shareware is to allow the user to try a fully-functional version of the program 
before deciding whether or not to purchase it.    This program is not free!    Permission is 
granted by Sagittal Software Company to use the trial version for up to one month, after 
which further use will be in violation of United States and International copyright law.

Most shareware versions will add an "unregistered program" notice to all printed documents 
and exported graphics as a reminder to users.    This notice is not printed by the purchased 
software.    In addition, shareware versions do not have unique identification codes and thus 
cannot use the security features to protect personal handwritten scripts from unauthorized 
use.

For information on how to purchase the ByHand(tm) program, click here.    You are not 
permitted to make copies of the registered version of the program except for backup 
purposes.



ShareWare Temporary Registration Expired

You have been using a temporary version of ByHand(tm) that was provided for 30 days from 
when Sagittal Software Company received your registration information and check.    This 
version has now expired.    You should have received a permanent copy of ByHand(tm) in the
mail.    If you have received this copy, please follow the instructions on the distribution disk 
to install it.    If you have not received the permanent copy, this may be because we have 
had difficulty processing your check or sending your disks.    Please contact Sagittal Software
Company at your convenience so that we can send you your fully functional and secure 
protected copy of ByHand(tm).

To print a new copy of the registration form, click here.



User Information Window

The first time you use the permanent version of ByHand(tm) you are asked for your name 
and company name in order to personalize your copy of the program.    This information is 
used to encrypt your personal handwritten scripts so that only your copy of ByHand(tm) can 
use them.    See Security Features for more information.    Your data is stored permanently in 
your USERID.BIN file.    If this file is deleted, you will be unable to access your protected 
scripts, and you will have to contact Sagittal Software Company for a new registration code.



Enter Registration Code

Sagittal Software Company has provided you with a registration code that will work only with
the serial number you supplied on your registration form, and that is shown at the bottom of 
this dialog.    Please enter the registration code exactly as supplied.    If the registration code 
is not accepted it may be because:

1.    You entered the code incorrectly,
2.    You supplied the wrong serial number on the form when you registered, or
3.    You have deleted your USERID.BIN file and thereby changed your serial number.

If you are unable to enter your registration code, please send another copy of your 
registration form to Sagittal Software Company including your current serial number from 
the Help|About menu.    If you have already paid, please indicate this on the form.

To print a new copy of the registration form, click here.



ShareWare Registration Form for ByHand (tm)

To purchase a copy of the ByHand(tm) program, select "Print Topic" from the File menu 
above (not the ByHand(tm) program menu) to print out this page.    Then fill out the form and 
send it to the address below along with a check for $49.95 in U.S. dollars plus 5.25% 
Massachusetts sales tax (if you request shipping to Massachusetts) plus $3.50 shipping and 
handling ($8.00 if outside the United States and Canada).      The total should be a check for 
$56.07 U.S. dollars ($53.45 if in the U.S. or Canada but not in Massachusetts, or $57.95 if 
outside the U.S. and Canada) made out to "Sagittal Software Company".    (Please read the 
Limited Warranty and License Agreement before registering.)    

We will send you a disk with the complete and unlocked ByHand(tm) program (including 
Security Features) and a short printed manual.    We will also give you an e-mail address for 
30 days of free technical support, and we will keep you informed of future upgrades and 
related products.    Please allow 3 weeks for delivery.    We apologize, but at this time we 
cannot accept credit cards, cash, foreign currency, or institutional purchase orders.

You are expected to register and pay separately for EACH copy of the ByHand (tm)
program that you are using.

Send this form plus payment ($56.07 or $60.57 US Dollars) to:

Sagittal Software Company
ByHand Shareware Registration
258 Harvard Street, Suite 301
Brookline, MA 02146, USA

Name: ____________________________________

Street Address: _____________________________

City,State,Zip/Postal code: ____________________

Country: ___________________________________

Telephone: _________________________________

Fax: ______________________________________

Email: _____________________________________

Serial Number from the Help/About menu in ByHand(tm):
_________-____________-____________
(If you include the serial number and either Email or Fax addresses, we will send you a 
temporary unlock code for your current copy of ByHand(tm) as soon as we receive your 
check.)

Comments: _________________________________

Thank you very much for registering!      Please tell your friends about this program!



Limited Warranty and License Agreement

This program, help files, instruction manual, and reference materials are sold as is, without warranty as to
their performance, merchantability, or fitness for any particular purpose.    The entire risk as to the results 
and performance of this program is assumed by you.    This program is sold without any express or 
implied warranties whatsoever.    Because of the diversity of conditions and hardware under which this 
program may be used, no warranty of fitness for a particular purpose is offered.    The user is advised to 
test the program thoroughly before relying on it.    The user must assume the entire risk of using the 
program.    Any liability of Sagittal Software Company, seller or manufacturer will be limited exclusively to 
product replacement as described below.    

To the original purchaser only, Sagittal Software Company warrants any magnetic diskettes supplied by 
Sagittal Software Company and on which the ByHand(tm) program is recorded to be free from defects in 
materials and faulty workmanship under normal use for a period of ninety days from the date of purchase 
and payment.    If during this ninety-day period the diskette(s) should become defective, they may be 
returned to the publisher for a replacement without charge, provided that you are a valid registered user 
of the ByHand(tm) program.

Your sole and exclusive remedy in the event of a defect is expressly limited to replacement of the 
diskette(s) as provided above.    If failure of a diskette has resulted from accident or abuse, the publisher 
shall have no responsibility to replace the diskette under the terms of this limited warranty.

Any implied warranties relating to the diskette(s), including any implied warranties of merchantability and 
fitness for a particular purpose, are limited to a period of ninety days from the date of purchase.    
Publisher shall not be liable for indirect, special, or consequential damages resulting from the use of this 
product. Publisher shall not be liable for any damages arising from prohibited or illegal use of this product.
Some states do not allow the exclusion of limitation of incidental or consequential damages, so the above 
limitations might not apply to you.    

This warranty gives you specific legal rights, and you may also have other rights which vary from state to 
state.

License Agreement 

This agreement is a license agreement between you and Sagittal Software Company, Inc., for the use of 
a single copy of the included software (Software) and documentation (Documentation).    The Software 
and Documentation are protected by both United States copyright law and international treaty provisions.  
Sagittal Software Company Inc. authorizes you to make only such archival copies of the Software as are 
necessary for the sole purpose of backing up your Software and protecting your investment for loss.    
Copying of the Software for any other reason or distribution of the Software is strictly prohibited.    This 
license is not a sale.    Title and copyrights to the Software and accompanying Documentation remain with
Sagittal Software Company, Inc.



Hardware Compatibility

The ByHand(tm) program is designed to run using:

1. An Intel-compatible 386 or faster processor, including 486 or Pentium or Pentium pro processors.      If a
386 is used, a 387 floating-point coprocessor is highly recommended.

2.    At least 4 megabytes of memory beyond the minimum needed for your operating system.    For 
Windows 3.1, this means a total of 6MB, for Windows 95 8MB, for Windows NT 20MB.

3.    Approximately 3 Megabytes of free disk space plus space for your data files.

4.    Any Windows(tm)-compatible graphic printer such as a laser printer or dot-matrix printer.

5.    Any Windows(tm)-compatible mouse.

6.    Most standard pen tablets that can be used to replace a mouse under Windows(tm).    The 
ByHand(tm) program has been tested using tablets from CalComp, CIC, and Wacom.    The pen should 
function so that touching the pen tip to the tablet performs a left mouse click.    The tablet should be 
configured in absolute coordinates mode so that each point on the tablet corresponds to a particular point 
on the display screen.    Note:    You do not need to have a pen tablet.    Any Windows(tm)-compatible
pointing device (including a mouse or trackball) can be used. 

7.    Any Windows(tm)-compatible display and video display driver hardware.    Note that video accelerator 
cards based on the S3 chip (including most cards made by Diamond Multimedia) will not work properly 
with certain pen tablets unless you use standard VGA mode at a 640x480 resolution.    A future 
Windows(tm) software upgrade may fix this - check with your video card or pen tablet manufacturer.

8.    A standard 1.44Mb 3.5 inch floppy drive.



TroubleShooting

Here are some suggestions for solving common problems that may occur while using the 
ByHand(tm) program.

EDITING:

Editing is slow
Click the speed-editing button (the small race-car icon at the top of the window) to maximize
editing speed.    You will not be able to see character formatting, but it will still print properly. 
You can also make the windows smaller, or use a lower screen resolution (such as 640x480, 
set in the Windows(tm) control panel under Display).    It is recommended that the 
ByHand(tm) program be used on 100Mhz or faster processors equipped with a floating-point 
unit (included on 486 and Pentium chips) and a window-accelerator graphics card.

The program does not run at all
ByHand(tm) will only run on a 386, 486, or Pentium-equivalent processor.    You need at least 
4MB or RAM in addition to the minimum needed for your operating system.    It has been 
tested under Windows 3.1, Windows 95, and Windows NT version 3.    Make sure you have at 
least one installed printer in your system, and that one of your printers is set as the default 
printer.

The letters are all messed up
Click the speed-editing button twice to repaint the screen.

PRINTING:

Printing is slow
Script printing uses hundreds of graphics commands to print each letter, and can sometimes
overwhelm certain printers.    Try using a lower resolution (dots-per-inch, or dpi) if your 
printer provides this option under the File|Print Setup menu.    Postscript printing is 
particularly slow.    Some postscript printers (including Hewlett-Packard models) allow you to 
send non-postscript data instead (such as PCL, or printer control language).    Try creating a 
different printer driver (using the Windows(tm) control panel) that is for a non-postscript 
version of your printer.    For example, choose a Laserjet 3 type printer driver rather than a 
Laserjet 4 - Postscript printer.

Windows stops responding when I try to print
Make sure your printer is turned on, on-line, and ready to print.    

ByHand(tm) keeps asking me to choose a printer
You need to have at least one default printer defined in the Windows(tm) control panel.

A copyright message appears every time I try to print
Unregistered shareware demonstration versions of the ByHand(tm) program print this 
message as a reminder that you need to register and pay for the program before using it.    
Click Here to register.

Nothing prints (the paper is blank)
Make sure that you set the pen color to black by choosing Edit|SelectAll and then Format|
PenColor.

The page margins are wrong while printing, or the text overflows
Use File|PrintSetup to choose the printer before printing, rather than clicking on Setup from 
the print dialog box that appears after you choose File|Print.



My printer shows a Print Overrun Error, or Out of Memory
Certain postscript printers (including Hewlett-Packard models) generate this error when 
printing using older versions of the Windows postscript drivers.    You need to obtain the 
newest postscript drivers from your printer manufacturer or Adobe systems 
(http://www.adobe.com).    Alternatively, you may be able to configure your printer to use a 
non-postscript mode such as PCL.

PEN TABLETS:

My pen tablet doesnt work at all in any windows application
First, try re-installing the tablet software and rebooting your system.    Then call your tablet 
manufacturer.    If your graphics card is based on the S3 chip (such as a Diamond Multimedia 
stealth card) then some versions of Windows(tm) will only respond to pen input if you set the
display type to generic VGA at 640x480 resolution in the control panel under Display.

My pen tablet works only in a special paint program
Make sure you have a tablet and driver software that let the tablet substitute for your 
regular windows mouse.    Some programs access the tablet directly without installing it in 
windows, and so ByHand(tm) will not be able to recognize the tablet.

My pen tablet works everywhere except in the ByHand(tm) program
Make sure that the mouse works, since ByHand(tm) treats the mouse and the tablet 
identically.    Make sure that you have your pen configured so that touching the tablet is 
equivalent to clicking the left mouse button.    Make sure that the pen entry windows are 
active by clicking on them.

FAX/MODEMS:

My fax/modem stops working when the pen tablet is installed
Most PC-compatible computers only allow you to use 2 serial ports at a time, even if you 
have more than 2 serial devices.    This means that you cannot have a serial mouse, pen 
tablet, and fax/modem operating at once.    To fix this, you need to make sure that all serial 
devices have different I/O addresses AND DIFFERENT IRQ SETTINGS.    This is not easy, since 
you usually are limited to choosing either IRQ 3 or 4 for serial ports.    Check your serial port 
and modem documentation to see if you can change one port to IRQ 5 or IRQ 10 (or some 
free IRQ value that does not conflict with other hardware in your system.    Run MSD from a 
DOS prompt to check for conflicts).    Then make sure that each serial port has a different I/O 
address (which will determine if it is called COM1, COM2, etc.).    Then you need to configure 
your software to find each serial port and its associated IRQ.    If your cards do not allow you 
to set the IRQ, you may have to buy an add-on configurable serial card if you need to use 
more than 2 serial devices.

Letters are hard to read when faxed
The dot-resolution on fax machines is usually not as good as for the screen or printers, so 
thin lines may not appear.    Use a thicker pen and larger characters when sending faxes.

SECURITY FEATURES:

I forgot my password
Re-install the ByHand(tm) program from your original distribution disks (not the shareware 
version).    Your password will be reset to blank.    

I lost the distribution disks
Contact Sagittal Software Company for a replacement set.    Send an email or letter with your



name, address, email, and serial number (from the Help|About menu).    

LETTER ENTRY:

Letters are missing some pieces or are completely blank
When you set the line breaks in Step 2, ByHand(tm) tries to figure out which lines go with 
which letter using the following rule:    All strokes that start between the same pair of line 
breaks are grouped together as a single letter.    So if the dot on an i or a j is slanted so that 
it lies above the next letter, then it will become part of the next letter and not the intended 
one.    Problems can also occur if you draw a letter from right to left, so that the start of a 
stroke is over the following character.    This might happen with a capital T or capital F.    To fix
these problems, remove the incorrect letters (select them in the document and choose Tools|
RemoveLetter) and re-enter the letters (using Tools|Modify) one at a time with only two line 
breaks (before and after).    In this special case, ByHand(tm) will associate all strokes with 
the single letter, no matter whether they start before or after the line breaks.    When you 
type the letters in Step 3, remember to type a space to skip over line breaks that do not 
represent letters.

Small pieces of letters disappear
On some monitors it is not possible to display very small dots or line segments that may be 
part of some letters.    These dots will usually print correctly however.    If this problem 
persists, try using a lower smoothing value in Step 1.    Also, during speed-editing some 
pieces of letters may not show on the screen.

Letters look strange when joined together
Certain letter pairs may not work well.    To fix this, enter an additional sample of the letter 
pair written together in Tools|Modify and do a Tools|ReScan.    When entering words that 
contain letters that would look strange anywhere else (such as a signature), select use these
letters only for these words in Step 3 to prevent the letters being used in other words.

OTHER PROGRAMS:

Script letters do not appear when I paste into other programs
Make sure that you chose Edit|CopyGraphic rather than just a regular Edit|Copy in order to 
place a ByHand(tm) graphic image on the clipboard.    Then this image can be pasted into 
any program that accepts either Windows(tm) Metafile format or    Windows(tm) Bitmap 
format.    You might have to choose to import this format in the other program using an Edit|
PasteSpecial command.

A copyright message appears when I paste to other programs
Unregistered shareware demonstration versions of the ByHand(tm) program print this 
message as a reminder that you need to register and pay for the program before using it.    
Click Here to register.



Edit Menu

The Edit menu provides commands to undo edits, access the clipboard, and to delete text.    
Most of these commands apply to blocks of text that you have selected by clicking at the 
start of the block and dragging to the end, highlighting the selected text along the way.

Cut Delete selected text and move it to the clipboard.
Copy Copy selected text to the clipboard.
Paste Move text from the clipboard to the current document.
Copy Graphic Copy picture of selected text to the clipboard.
Page Break Insert page break in document.
Select All Select all text in active document.



File Menu

The File menu provides commands for creating new files, opening existing files, saving files, 
printing files, and exiting the application.

New Create a new, untitled, document.
Open Open an existing document file.
Close Close the current document.
Change Password      Change the program password.
Save Save the current document if its contents have changed.
Save As Save the current document under a new name.
Print Print the current document.
Print Preview View a sample printout of the current document.
Print Setup Set printer characteristics.
Exit Exit the ByHand(tm) application.



Security Features

If you enter a sample of your own handwriting, there is the possibility that unauthorized 
users could attempt to use it improperly.    The ByHand (tm) program has several built-in 
security features that help to protect against this.

Every registered version of the program (but not the shareware version) has a unique serial 
number.    In the Tools|Set Script Information command, if you set the Secure Protect check 
box for any script (and    it) then that script can only be re-opened by your copy of the 
ByHand (tm) program.    This prevents other people from accessing your handwriting using 
other copies of the program.

You can also set a password for the program itself, so that an unauthorized user cannot 
access your scripts even if they make a copy of your version of the ByHand (tm) program.

If you want another trusted person (such as a secretary or co-worker) to be able to use your 
handwriting, then you should make an exact copy of your ByHand (tm) program including 
the USERID.BIN file for them to use.    (Note that you are expected to register and pay for 
each copy you make.)    

Do not give copies of your USERID.BIN file to anyone else or allow other people to 
make copies, since if you do you will never be able to protect against 
unauthorized use of your personal handwriting!

No security system is perfect, and Sagittal Software Company recommends that for the best 
security, you should maintain your personal scripts only on a separate floppy disk and keep 
this disk locked up when not in use.



Search Menu

The Search menu provides commands to find and replace text.

Find Find a pattern of text.
Replace Replace one pattern of text with another.
Next Find and/or replace the next occurrence of text pattern.



Format Menu

The Format menu provides commands to set page, paragraph, and character formatting 
parameters.

Page Set Margins and print options
Paragraph Set Linespacing for selected region
Character Set pen type and letter size
PenColor Set pen color
Repaginate Reset line breaks according to document margins



Format | Page

The Format|Page command displays the Page Setup dialog which allows you to set the 
document margins and other printing parameters.

Values for left, right, top, and bottom margins are given in inches, and measure the distance 
from the borders of the maximum printable area to the margins of your text.    In other 
words, a right margin of 1 inch specifies that there will be 1 inch of space between the right 
edge of your text and the rightmost printable part of the page (which is usually slightly 
inside the true right edge of the page since most printers cannot print all the way to the 
edge).

To look more "human", you can choose...

I. Ragged Left Margin to have the left edge of each line indented by a small random amount.

II. Wandering Baselines to have the letters within a line move randomly up or down.

Ragged Left Margin and Wandering Baselines affect only the printed or previewed 
document, not the editing window.



Format | Paragraph

The Format|Paragraph command sets the line spacing for the paragraph containing the 
insertion point.    The value is specified as a multiple of the standard line spacing.    For 
example, double spacing is a value of 2.0, half-spacing is a value of 0.5.    The standard 
spacing is proportionally adjusted so that the highest character in each line comes to just 
below the lowest character in the previous line.    Thus lines do not all have equal height.

Choose Fixed Line Height to make all lines have the same height regardless of how high the 
characters are in each line.    Some lines may overlap or leave extra space this way.

Paragraphs are ended by hitting the Return or Enter key.    A line ended this way is 
considered to have a hard return and will not be joined to the following line.    You can delete 
the hard return just as you would delete any character using the backspace key.



Format | Character

The Format|Character command chooses the parameters used to draw individual letters.    If 
a region of text is selected in the current document, then it will change the parameters for 
only the selected text.    Otherwise, the formatting will apply to all future typed characters.

Note:    If Speed Editing is selected, then the formatting will be applied, but it will not be 
displayed on-screen in order to maximize speed.    Printed output will contain all the 
formatting parameters that were specified.

Pen Type selects either ballpoint (fixed width), calligraphic (diagonal nib), or felt tip (varying
width) pens.

If Messy Ink is checked each pen will draw "realistically" as if the ink did not flow perfectly.

Letter Size Factor determines the total size of each letter.    Setting this to 1.0 gives the 
default size which is close to the scale that the letter was originally entered.    0.5 gives 
smaller and 2.0 larger sizes.

Pen Thickness specifies the size of the pen used to draw letters.    Different thicknesses 
look best with each pen, with messy ink, and on different printers.    You should experiment 
to see what works best for your purposes.

There are toolbar buttons to select each of the three pen types, as well as three of the most 
common pen thicknesses.



Format | Pen Color

The Format|Pen Color command allows you to choose the color of ink used to show 
characters on-screen and on color printers.    If a region of letters is selected (and 
highlighted) in the current document, then the color of these letters will be changed.    
Otherwise, the color of all future characters typed (up to the next Pen Color command) will 
be set.    Keep in mind that not all printers are capable of printing all the colors that can be 
displayed on your screen.



Format | Repaginate

The Format|Repaginate command adjusts the line and page breaks in the current document 
to match the selected document margins.    This is necessary if the margins have been 
changed, or if a line has extended beyond the right margin.

Repaginate inserts "soft" line breaks such as those that would be inserted automatically as 
you type.    "Hard" line breaks are those that occur when you type a carriage return (Enter).    
The difference is that repaginate is allowed to re-join two lines that are separated by only a 
soft return, but it cannot join lines separated by a hard return.    Hard returns are used for 
paragraph endings and to insert blank lines in a document.

Similarly, there are both "soft" and "hard" page breaks.    Repaginate inserts and removes 
"soft" page breaks wherever needed.    But you can insert a "hard" page break using the Edit|
Page Break command.    This causes a page break that Repaginate cannot move.



Script Menu

The Script menu shows the available handwriting styles.    Only one style can be used at a 
time, and it will be applied to all open documents.    The toolbar shows the name of the 
currently active script.    When you choose a new script off the Script menu, it will be read 
from disk into memory and all documents will automatically be Rescanned to convert them 
to the new script.    The new script stays in effect until you choose a different one.

The available scripts are found by looking for all files with the .SCR extension in the same 
directory as the ByHand(tm) program (usually C:\BYHAND).    If you have script files in other 
directories, they will need to be moved into this directory before they will be available.    
Note that this extension is also used by other programs for different purposes, so not all files
with the .SCR extension are ByHand(tm) script files.



Tools Menu

The Tools menu provides commands to enter new handwritten script styles or modify 
existing ones.    It also performs "Rescan" operations to associate new letter shapes with 
characters in the document.

Rescan Document Re-assigns letter shapes to characters in the document.
New Script Creates a new blank script file.
Modify Script Enter new letter shapes and add them to the current script.
Save Script Saves the current script.
Save Script As Saves with a new name or directory.
Set Script Information Sets Name, Author, and security information
Remove Letter Data Removes selected letters from the script database.
Set Space Width Change width of space character.



Tools | Modify Script

The Tools|Modify Script command allows you to add handwritten characters to the current 
script database.    The database consists of a list of letter shapes that you draw and it 
remembers the sequence in which you drew them.    There can be many examples of each 
letter.    If a document contains a word or a sequence of letters that occurs in exactly the 
same order as a sequence of letters entered during Tools|Modify Script, then it will choose 
the specific letter shapes from that sequence.    This allows you to enter your signature just 
like any other sequence of letters, and the ByHand(tm) program will substitute the exact 
shapes from your signature whenever it sees your full name appear in a document.    It will 
also attempt to match up letter pairs, triplets, etc. from examples that you have entered.    
(Note: this will not necessarily occur automatically as you type, since the ByHand(tm) 
program does not know the letters you have not yet typed.    You need to issue a Tools|
Rescan Document command.)    Because of this feature, ByHand(tm) documents appear to 
be handwritten since letter shapes change both randomly and depending on the letters 
around them, exactly as in your own handwriting!

You can enter handwriting samples using any device that can be configured to work like a 
mouse.    A pen tablet works best, but a mouse, touchpad pointer, or trackball is also 
possible with a bit of practice.    You must configure your device so that it controls the 
Windows(tm) mouse pointer.    You will only be able to draw when the left-mouse-button (or 
equivalent) is down.    For pen tablets, this usually means that the pen is on the tablet.    For a
trackball or touchpad you may have to hold one of the buttons down to draw, just as you 
would in any paint/draw application.

Handwriting entry consists of three steps:

Step 1 Draw letter shapes
Step 2 Set letter shape boundaries and height
Step 3 Assign characters to letter shapes

You must save your changes using Tools|Save Script when you are done.    You do not have to
enter the entire script in one session.    You can enter new letter shapes any time, and add 
additional shapes for existing letters in order to improve the look of your documents.

If you make a mistake entering a script or if you do not like the way a particular letter looks, 
you can remove it from the database in 2 ways.    In Step 3,    if you assign that shape to the 
<space> character instead of to a letter, then ByHand(tm) will delete the shape.    But you 
can also remove a bad letter shape at any time by highlighting it when it occurs in any 
document and then choosing Tools| Remove Letter Data.    Remember to save your changes!



Modify Script: Step 1

The first step in entering handwriting data is to draw in the letter shapes.    There are three 
horizontal lines in the drawing window.    The lowest is the baseline, and descenders for "y", 
"g", "j", and "p" should go below this line.    The middle line should indicate the top of all 
"short" characters such as "a", "o", "c", or "e".    The top line is for the top of "tall" characters
such as capital letters, numbers, and "h", "t", "l", or "f".    These lines are only suggested 
guidelines, but it is important that you remain consistent when entering characters so that 
all letters end up with similar heights.    You can adjust the position of these lines in Step 2, 
so don't worry about them too much right now.    You can draw as many letters or words as 
will fit within the width of the box.    Draw all the letters at the same vertical position.    It is 
best to draw whole words rather than single letters, in order to get the spacing right, and to 
create smoothly joined cursive letters.

When you are done, you can choose a smoothing value in the box at the lower right.    A 
value of 80 to 90 is right for most people.    A larger value will smooth your strokes further, 
but you may lose the fine details of the writing.    You will see the result of smoothing 
displayed in Step 2, and you can return to Step 1 to change this value if you like.

Choose OK when you are done.    You can choose Clear to erase all current lines and start 
over, or Cancel to exit the handwriting entry process.



Modify Script: Step 2

The second step in entering handwriting data is to tell the ByHand(tm) program where each 
letter stops and starts.    This is as important for cursive letters as for printing.    You will see 
the smoothed shape data you entered from Step 1 in the window.    (If it has been over-
smoothed so that details are missing, click Back to return to Step 1 and decrease the 
smoothing value.)

Use the left mouse button (or equivalent) to click between letters.    As you do so, you will 
see a short vertical "break" bar appear.    For cursive writing, you should use the break bars 
to "cut" the strokes mid-way between each pair of letters.    For printed writing, you can 
place breaks in the space between two letters.    You should also place a break before the 
first letter and after the last letter of each word to indicate the widths of these letters.    This 
means that if you enter two words together, there will be two breaks between them (one at 
the end of the first word, and one at the beginning of the second).    

Each pair of letters can only have a single break separating it.    If you make a mistake, you 
can erase a break-mark by clicking on it again, or by using the backspace key to remove the 
last mark.

After you have set the letter breaks, use the small solid boxes at the right of the lower and 
middle horizontal lines to align these lines with the characters as described in Step 1.    The 
ByHand(tm) letter-entry system uses the size of letter shapes in relation to these lines to 
determine the printed size of letters.    If you are inconsistent here, different letters will have 
very different sizes.

Click OK to go to Step 3 when you are done, or Back to return to Step 1, Clear to erase all 
the letter breaks, or Cancel to exit from handwriting entry.

How Letters are Put Together:

The ByHand(tm) program treats the shape data as a set of strokes.    It has to decide which 
strokes go with each letter.    If you "cut" a stroke in two, then the two pieces become two 
separate strokes that are associated with the letters before and after the break.    Note that a
stroke will only be cut if it crosses the break line going from left to right.

Any stroke that is not cut by a letter break belongs to the region in which it starts.    This 
means that a stroke that starts to the left of a break mark will become part of the letter to 
the left, no matter how far to the right it goes (if it goes around all the breaks so that it is 
never "cut").    Similarly, a stroke that starts to the right of a break mark will become part of 
the letter to the right, no matter how far to the left it goes (if it is not "cut"). The "start" of a 
stroke is determined by which end you drew first in Step 1.    

Strokes to the left of the first break mark become part of the first character, and strokes to 
the right of the last break mark become part of the last character.    So when all else fails you
can create any shape you like by entering only one letter shape at a time.    Beware of dots 
on "i"s and "j"s that end up above (and thus part of) the following letter.    Also, beware of 
double-crossed "t"s since you cannot have two different break marks for the cross and the 
rest of the letter (unless you can hit both with the same break mark).



Modify Script: Step 3

The third and last step to entering handwriting data is to tell the ByHand(tm) program which 
letter shape goes with which typewritten character.    You will see your letter shapes and the 
breaks.    Type the letters in the edit window on the lower right exactly in the order that the 
shapes appear in the window above.    If you make a mistake, you can use the backspace key
to delete the character.    The letters will appear over the shapes they should represent.    You
can have as many examples of each letter as you like.

If you do not like a shape or do not wish to assign it a character, simply type a space 
character for that shape.    Any shape with a space letter will not be stored in the database.    
Remember to type a space between words.

Remember that you can have as many examples of each letter as you like.    ByHand(tm) will
try to find the best example to use in your documents depending on the surrounding letters. 
If there is more than one good choice, it will pick one randomly to simulate normal 
handwriting variability.

Click the use these letters only for these words box to prevent these letters being re-
arranged for use in other words.    For example, if you enter your signature, the individual 
letters may not be useful (or even readable!) so you might want to check this box.    Then 
these letter shapes will only be used if the entire signature is typed and a Tools|ReScan is 
performed.

When you are done, click OK to finish, or Back to return to Step 2, or Cancel to exit from 
handwriting entry without saving the letter shapes in the database.    If you click OK, you will
be given the option of returning to Step 1 to continue entering more new letters.    If you do 
not continue, you can always choose Modify Script again later to enter more letters.

After you click OK, ByHand(tm) asks if you want to save the script to disk.    If you choose 
No, you can always save it later using Tools|Save Script.



KTools | Open Script

The Tools|Open Script command reads a script database from the disk and uses the new 
database to display the characters in all open documents.    Only one handwriting script can 
be open at a time, and the same script will apply to all documents.    If changes have been 
made to the current script when the Tools|Open Script command is issued, the ByHand(tm) 
program will ask if the changes should be saved first.    The default extension for script 
database files is ".SCR".

Note that ByHand(tm) document files do not specify any particular script.    You must load the 
desired script each time, or make it the default using Tools|Set Script Information.

If open documents contain characters for which no shape is available in the opened script 
database, then an error is shown and the characters are printed as blanks.    You can use 
Tools|Modify Script to enter shapes for these characters and Tools|Save Script to save the 
modified script.



Tools | New Script

The Tools|New Script command clears the current script database from memory and calls 
Tools|Modify Script to enter handwritten letters into a new database.    If changes have been 
made to the current script, then the ByHand(tm) program asks if you want to save the current
script to disk before clearing it.      If you do not do this, then any changes you have made to 
the current script (using Tools|Modify Script) will be lost.

A new script has no letters in it and thus cannot be used to display documents until you 
have entered at least a few letters.    This means that you must close all active documents 
before you can enter a completely new script.    ByHand(tm) will do this automatically, but 
you may be asked to save these documents first if they have any unsaved changes.

The new script dialog will be displayed asking you for a name and identifying information for 
your new script.    ByHand(tm) will then automatically start a Modify Script session so that 
you can start to enter letter shapes into your new script.

You must use Tools|Save Script to save your new script database to disk after you have 
entered the new letters.

Note that you generally have to enter all lower-case, upper-case, numeric, and symbol 
characters in order to be able to write complete documents in your script.



Tools | Save Script

Saves the current script to a handwriting data file on disk.    The script is saved using its 
current name as shown in the script name box on the toolbar.    For example, the COPPER 
script will be saved to COPPER.SCR in the application directory (usually C:\BYHAND).    If you 
do not save your scripts, then any changes you make will be lost when you exit the 
ByHand(tm) program or change to a different script.



Tools | Save Script As

Saves the current script to a handwriting data file on disk.    You can specify a new name for 
the script, or just click OK to use the current name.    The default extension is ".SCR".    If 
you attempt to save to an existing file, the ByHand(tm) program will ask for confirmation.    If 
you save over an existing file, you will not be able to recover the old version.    Although you 
can save scripts to any directory, only scripts in the application directory (usually C:\
BYHAND) that have the .SCR extension will be accessible on the Scripts menu.



Tools| Set Script Information

Sets information parameters for the current script.    The parameters are not saved until you 
choose Tools|Save Script.    You can set the following parameters:

Script Name The formal name for the script, such as 1800s Copperplate Fancy.    This is 
different from the filename given by MS-DOS or Windows, which might be 
COPPER.SCR.

Author Credit where credit is due!

Company To identify the author, or a professional source of the script.

Comments Suggested size, pen types, and uses.

Secure Protect     When checked, this script is protected and can only be used by this 
copy of ByHand(tm).    This option is only available when a password is set.    
See Security Features for more details.

Read Only When checked, the script cannot be modified.    To make changes, you will 
need to make a new copy of the script by saving (Tools|Save Script As) using a
different filename and without Read Only checked.

Default Startup Script    When checked, sets this script as the default script that loads first
whenever ByHand(tm) is started.



Tools | Rescan Document

The Tools|Rescan Document command randomly chooses a new letter shape for each 
character in the current document from all the possibilities in the currently selected script 
database.    If a word or part of a word containing a matching series of letters was entered 
during a Tools|Modify Script session, then that sequence of letter shapes will be used.    
Otherwise, the ByHand(tm) editor finds the best choice of shape depending on the position 
within the word and the surrounding letters.    

This command can be performed many times in a row to see alternate possibilities.    You 
should always perform a Rescan Document before printing, because the letters chosen by 
Rescan Document are better than those chosen while you are typing (since the ByHand(tm) 
editor does not know the letters you haven't typed yet).



Tools | Remove Letter Data

The Tools|Remove Letter Data command permanently deletes the letter shapes for the 
currently selected text from the current script database.    It substitutes other examples of 
these letters, if other examples exist.    If not, an error is generated and a blank space is 
printed.    This is the only method of removing letters that are unreadable or entered 
incorrectly in a Tools|Modify Script session.    If you want to use a different letter shape in a 
word but do not want to permanently delete any shapes, use Tools|Rescan Document 
instead.

For example, if while editing a document you notice that the letter h in one of the words 
looks incorrect, you can select that letter (by dragging over it with the mouse) and then 
choose Remove Letter Data.    This will remove that letter shape from the script.    If there 
is another h in the script, it will be used instead in your document.    Otherwise, you will see 
an error and no hs will be visible until you enter a new h using Tools|Modify Script.    You only 
need to do this once for each letter shape you do not like.    The incorrect h will be 
automatically removed from all places in all documents.

Remove Letter Data modifies the script database, but these changes will not be saved until 
you choose Tools|Save Script.



Tools | Set Space Width

The Tools|Set Space Width command allows you to modify the width that the space 
character occupies for the selected handwriting script.    Note that the space width also 
determines the minimum line height of a blank line in the document (non-blank lines are 
given as much space as needed to accomodate all characters on the line).    

Choosing this command results in a dialog in which the space width can be increased or 
decreased from its current value by multiplying with a decimal number.    To double the 
space width, choose a value of 2.0.    To halve the space width, choose a value of 0.5.    The 
new value will be immediately applied to all open documents.    The value will not be saved, 
however, unless you perform a Tools|Save Script command.



Window Menu

The Window menu provides commands to control the position and layout of all your 
document windows.

Cascade Resize and position all document windows in an overlapping pattern.
Tile Resize and position all windows in a non-overlapping pattern.
Arrange Icons Align all iconized windows along a grid.
Close All Close all windows.



Copying Text

To copy text, you first select the text by dragging over it with the mouse (holding the left 
button down), then copy it to the clipboard, then paste the copy back into the document at 
the desired point.    

To copy the selected text to the clipboard, select it and choose Edit|Copy from the menu.

To paste text to a document from the clipboard, position the cursor at the desired insertion 
point, and choose Edit|Paste    from the menu.    



Deleting Text

To delete text from a document, select the text, and choose Edit|Cut or or type the <Delete>
or <Backspace> keys.    Cut will put the deleted text in the clipboard, and Delete will simply 
delete it.



Exiting

To exit the application, choose File|Exit from the menu.



Edit Window

The edit windows in this application allow reading, editing, printing and saving ByHand(tm) 
document files.



Drag/Drop from the File Manager

A ByHand(tm) document file can be opened into an editor in the application by dragging the 
file from the File Manager, and dropping it on the ByHand(tm) main window.



Printing

There are three commands on the File menu which support printing of documents from the 
application.    File|Print Setup is used to select and configure a printer device and set default 
margins for the displayed document.    File|Print Preview displays a special preview window 
which shows how the document will appear when printed.    File|Print causes the current 
document to be printed.    You can also print by clicking the small printer icon button on the 
speedbar at the top of the window.



Edit Copy Command

The Edit|Copy command leaves the selected text intact and places an exact copy of it in the 
clipboard.    To paste the copied text into another document or a different place in the same 
document, choose Edit|Paste.    

To export text to a different application, use Edit|Copy to place the text on the clipboard, and
simply paste into the other application using its Paste command.    Other applications will 
only be able to paste the text data without the handwritten letter shapes.    Line breaks (soft 
and hard returns) will be converted to MS-DOS(tm) carriage returns, and page breaks will be 
converted to Ascii Formfeed characters.    (You can also use the File|Save As command to 
write an MS-DOS text file that can be read by other applications.)

To export the graphic handwriting as a picture (in Metafile or Bitmap format) that can be 
pasted into painting or other graphics applications, choose Edit| Copy Graphic.



Edit Copy Graphic Command

The Edit|Copy Graphic command copies a picture of the currently selected handwritten text 
to the clipboard.    This picture can be pasted into other applications that accept windows 
"metafile" or bitmap format data.    The picture will print out at the full resolution of 
whichever printer was selected at the time of the Copy Graphic command (see File|Print 
Setup).



Edit Page Break Command

The Edit|Page Break command inserts a "hard" page break in the active document at the 
current insertion point.    (See Format|Repaginate for a description of soft and hard page 
breaks.)    You need to insert hard pages whenever the following text should start at the top 
of a new page.    For example, in a series of envelopes, you would use a hard page break to 
separate each address.



Edit Select All Command

The Edit|Select All command selects all text in the currently active document window.



Edit Cut Command

The Edit|Cut command removes the selected text from your document and transfers it to the
clipboard.    Choose Edit|Paste to paste the cut text into another ByHand(tm) document or 
another location in the same document. The text remains selected in the clipboard, and can 
be pasted multiple times. 

If you paste into another application, then line breaks (soft and hard returns) will be 
converted to MS-DOS(tm) carriage returns, and page breaks will be converted to Ascii 
Formfeed characters.    (You can also use the File|Save As command to write an MS-DOS text 
file that can be read by other applications.)



Edit Paste Command

The Edit|Paste command inserts the text currently in the clipboard into the current window 
at the cursor position.    

To import text from another application, use that applications Copy command to place the 
text on the clipboard, then use ByHand(tm)s Edit|Paste command to insert the text in your 
handwriting document.    All carriage returns will become hard returns.    If you want to insert 
a page break before a line of the document, place a period (.) as the first character of that 
line, and ByHand(tm) will change it to a Hard page break.

You can also use the File|Open command to read an MS-DOS file directly.



File Close Command

File|Close closes the currently active window.    If the document has not been saved, you will 
be prompted for a filename to save to.



File Change Password Command

File|Change Password sets or changes the password for the ByHand(tm) program.    If the 
password is not blank, then every time ByHand(tm) is run, you will be asked to enter the 
password, and the program will exit unless you enter the correct one.    Passwords can be 
any combination of letters, numbers, or space characters.    Make sure you write down your 
new password, since if you lose it there is no way to access any protected scripts that you 
may have created.    

In order to change the password, you need to type your old password correctly (leave this 
blank if no password was assigned previously) and type the new password twice for 
confirmation.    Then click OK.    You may set the new password to be blank in order to disable
password protection.    If you click CANCEL then no changes are made to your current 
password.

Password protection is important in order to prevent unauthorized use of your personal 
scripts. See    Security Features for more information.

Password protection is not available in unregistered shareware copies of ByHand(tm).    See 
Registration Information.



Password Dialog

The password is set by the File|Change PasswordPASSWORD command.    If it is not blank, 
you will be asked for this password every time ByHand(tm) starts.    Password protection is 
important in order to prevent unauthorized use of your personal scripts. See    Security 
Features for more information.

Password protection is not available in unregistered shareware copies of ByHand(tm).    See 
Registration Information.



Password Warning

The password is set by the File|Change PasswordPASSWORD command.    If it is not blank, 
you will be asked for this password every time ByHand(tm) starts.    Password protection is 
important in order to prevent unauthorized use of your personal scripts. If you do not choose
a password, then anyone with access to a copy of this version of ByHand(tm) will be able to 
use your personal scripts to generate documents in your handwriting.    See    Security 
Features for more information.



File Exit Command

The File|Exit command exits the ByHand(tm) program.    If you have modified documents 
without saving, you will be prompted to save before exiting.    If you have modified the 
current script without saving, you will also be prompted to save the script.



File New Command

The File|New command opens a new, untitled document, and makes it the active window. 
The application prompts you to name untitled documents when they are closed.



File Open Command

The File|Open command displays the Open-File dialog box so you can select a file to load 
into a new document window.    You can open files of three different types:

1.    ByHand document files (extension .BYH) contain all the text and formatting information 
for ByHand documents.

2.    ByHand template files (extension .BYT) are exactly the same as document files, but are 
useful for saving formatting information for different printers or paper types that you re-use 
in many different documents. 

3.    Ascii text files (.TXT) have no formatting information, but are useful to import text from 
other wordprocessors. All carriage returns will become hard returns (paragraph endings).    
You can insert a hard page break before a line by starting that line with a period (.) 
character.



File Print Command

The File|Print command prints the contents of the active window.    Use File|Print Preview to 
see how the document will be laid out on printer pages.    Use File|Print Setup to select a 
printer, and to set printer options.    See TroubleShooting for hints on speeding up printing.



File Print Preview Command

File|Print Preview opens a special window that shows how the active document will appear 
when printed.    The preview window shows one or two pages of the active document as they
would be laid out on printer pages.    The left and right arrow controls on the window allow 
you to page through the pages of the document.    Click the close box in the upper left of the 
window (upper right under Windows95(tm)) to leave Print Preview mode.



File Print Setup Command

The File|Print Setup command displays the Printer Setup dialog box which allows you to 
select and configure the printer to be used to print each document.    The printer information 
is saved separately for each document, so that different documents can use different 
printers and printer settings (such as margins, landscape/portrait orientation, paper tray, 
etc.).



File Save Command

The File|Save command saves the document in the active window to disk. If the document is 
unnamed, the Save File As dialog box is displayed so you can name the file, and choose 
where it is to be saved.    ByHand(tm) files have a default extension of ".BYH" . You can save 
files of three different types:

1.    ByHand document files (extension .BYH) contain all the text and formatting information 
for ByHand documents.

2.    ByHand template files (extension .BYT) are exactly the same as document files, but are 
useful for saving formatting information for different printers or paper types that you re-use 
in many different documents.    

3.    Ascii text files (.TXT) have no formatting information, but are useful to export text to 
other wordprocessors.    All line breaks (soft and hard returns) will be converted to MS-
DOS(tm) carriage returns, and page breaks will be converted to Ascii Formfeed characters.



File Save As Command

The File|Save As command allows you to save a document under a new name, or in a new 
location on disk.    The command displays the Save File As dialog box.    You can enter the 
new file name, including the drive and directory.    All windows containing this file are 
updated with the new name.    If you choose an existing file name, you are asked if you want 
to overwrite the existing file.    Files are saved using the same format as for File|Save .



Search Find Command

The Search|Find command searches the current document for a text pattern.    The command
displays the Find dialog which controls the search process.    Options in the dialog determine 
whether the search should be conducted forwards or backwards through the document, and 
whether the search should continue from the beginning if no match is found by the end of 
the document.    When a match is found, it is highlighted in the document.

Check "Reverse" to search backwards.
Check "Wrapped" to continue searching from the beginning of the document after the end.



Search Next Command

The Search|Next command repeats the last Find operation.



Search Replace Command

The Search|Replace command searches the current document for a text pattern, and 
replaces occurrences of the pattern with new text.    The command displays the Replace 
dialog which controls the search/replace process. The dialog specifies the pattern to search 
for, and the text to replace occurrences with.    Options in the dialog determine whether the 
search should be conducted forwards or backwards through the document, and whether the 
search should continue from the beginning if no match is found by the end of the document. 
Options also determine whether to replace all occurrences of the text in the document, and 
whether to ask before making each change.

Check "Reverse" to search backwards.
Check "Wrapped" to continue searching from the beginning of the document after the end.
Check "Replace All" to change all occurrences in the current document.
Check "Verify" to double-check each replacement before the document is changed.



Window Arrange Icons Command

The Window|Arrange Icons command arranges all iconized windows into rows along the 
bottom of the application's main window.



Window Cascade Command

The Window|Cascade command arranges all document windows from the top-left position of 
the application's main window so that the title bar of each is visible.



Window Close All Command

The Window|Close All command closes all document windows open in the application.



Window Speed Editing

The Window|Speed Editing command uses several shortcuts to maximize the speed of on-
screen display of documents.    It does not affect the stored form of the document or the 
printed output.    When Speed Editing is checked, all characters are shown using thin lines 
and without messy ink (see Format|Character).    Also, the characters are drawn at a lower 
resolution than normal, which occasionally results in dropped strokes.    To see how the 
printed document will look, either disable Speed Editing (by choosing the menu item again) 
or select File|Print Preview.



Window Tile Command

The Window|Tile command arranges all document windows side-by-side in a non-overlapping
pattern.



Open Script Dialog

The list of available scripts is displayed.    To choose a script, click on its name and then click 
OK, or hit the <enter> key.    Click on Cancel to leave the current script unchanged.    
ByHand(tm) can only have one script loaded at a time, and this script is used for all open 
documents.



New Script Dialog

This dialog is displayed when you are about to enter a new script after selecting Tools|New 
Script.    You need to select a name for the new script.    This name must be between 1 and 8 
characters long, can contain only uppercase letters or numbers, and cannot begin with a 
number (this is for compatibility with Windows 3.1).    When you save the script to disk, it will
be saved with the filename NAME.SCR    (where NAME is the name you chose).    For example,
the Copperplate script is called COPPER and is saved as the file COPPER.SCR.    You should 
not choose the name of an already existing script when creating a new script.    You can 
always change the name later using Tools|Save Script As.    By default, scripts are saved in 
the same directory as the ByHand(tm) application (usually C:\BYHAND).    Only scripts in this 
directory will be accessible to the program.

You can also enter a longer description for your script such as Copperplate Italic Script.    This
description can be changed later using Tools|Set Script Information.

Click OK to create the new script and proceed to enter new letter shapes just as you would 
for Tools|Modify Script.    Click Cancel to exit without creating a new script and to restore the
currently active script.





The Toolbar
The Toolbar is a row of buttons at the top of the main window which represent application commands. 
Clicking one of the buttons is a quick alternative to choosing a command from the menu.    Buttons on 
the toolbar activate and deactivate according to the state of the application.

Button Action Menu Equivalent

Create a new document File|New

Locate and open a file File|Open

Save the file in the active window File|Save

Cut selected text to Clipboard Edit|Cut

Copy selected text to Clipboard Edit|Copy

Paste text from Clipboard Edit|Paste

Undo previous editor action Edit|Undo

Search for text Search|Find

Repeat last Find or Replace operation Search|Next

Print the active window File|Print

Preview the printout of the active window File|Print Preview

Display help file contents (None)



Windows Keys
Cursor Movement Keys
Dialog Box Keys
Editing Keys
Help Keys
Menu Keys
System Keys
Text Selection Keys
Window Keys



Cursor Movement Keys

Key(s) Function

Arrow key Moves the cursor left, right, up, or down in a field.
End or Ctrl+Right Arrow Moves to the end of a field.
Home or Ctrl+Left Arrow Moves to the beginning of a field.
Pape Up or Page Down Moves up or down in a field, one screen at a time.



Dialog Box Keys

Key(s) Function

Tab Moves from field to field (left to right and top to bottom).
Shift+Tab Moves from field to field in reverse order.
Alt+letter Moves to the option or group whose underlined letter matches 

the one you type.
Arrow key Moves from option to option within a group of options.
Enter Executes a command button.

Or, chooses the selected item in a list box and executes the 
command.

Esc Closes a dialog box without completing the command. (Same as
Cancel)

Alt+Down Arrow Opens a drop-down list box.
Alt+Up or Down Arrow Selects item in a drop-down list box.
Spacebar Cancels a selection in a list box.

Selects or clears a check box.
Ctrl+Slash Selects all the items in a list box.
Ctrl+Backslash Cancels all selections except the current selection.
Shift+ Arrow key Extends selection in a text box.
Shift+ Home Extends selection to first character in a text box.
Shift+ End Extends selection to last character in a text box



Editing Keys

Key(s) Function

Backspace Deletes the character to the left of the cursor.
Or, deletes selected text.

Delete Deletes the character to the right of the cursor.
Or, deletes selected text.



Help Keys

Key(s) Function

F1 Gets Help and displays the Help Index for the application. If the 
Help window is already open, pressing F1 displays the "Using 
Windows Help" topics.
In some Windows applications, pressing F1 displays a Help topic
on the selected command, dialog box option, or system 
message.

Shift+F1 Changes the pointer to  so you can get Help on a specific 
command, screen region, or key. You can then choose a 
command, click the screen region, or press a key or key 
combination you want to know more about.

(This feature is not available in all Windows applications.)



Menu Keys

Key(s) Function

Alt Selects the first menu on the menu bar.
Letter key Chooses the menu, or menu item, whose underlined letter 

matches the one you type, when a menu has focus.
Alt+Letter key Pulls down the menu whose underlined letter matches the one 

you type.
Left or Right Arrow Moves among menus of the main menu bar.
Up or Down Arrow Moves among menu items within a drop-down menu.
Enter Chooses the selected menu item.



System Keys

The following keys can be used from any window, regardless of the application you are 
using.

Key(s) Function

Ctrl+Esc Switches to the Task List.
Alt+Esc Switches to the next application window or minimized icon, 

including full-screen programs.
Alt+Tab Switches to the next application window, restoring applications 

that are running as icons.
Alt+PrtSc Copies the entire screen to Clipboard.
Ctrl+F4 Closes the active window.
F1 Gets Help and displays the Help Index for the application. (See 

Help Keys)



Text Selection Keys

Key(s) Function

Shift+Left or Right Arrow Selects text one character at a time to the left 
or right.

Shift+Down or Up Selects one line of text up or down.
Shift+End Selects text to the end of the line.
Shift+Home Selects text to the beginning of the line.
Shift+Page Down Selects text down one window.

Or, cancels the selection if the next window is 
already selected.

Shift+Page Up Selects text up one window.
Or, cancels the selection if the previous 
window is already selected.

Ctrl+Shift+Left or Right Arrow Selects text to the next or previous word.
Ctrl+Shift+Up or Down Arrow Selects text to the beginning (Up Arrow) or end

(Down Arrow) of the paragraph.
Ctrl+Shift+End Selects text to the end of the document.
Ctrl+Shift+Home Selects text to the beginning of the document.



Window Keys

Key(s) Function

Alt+Spacebar Opens the Control menu for an application window.
Alt+Hyphen Opens the Control menu for a document window.
Alt+F4 Closes a window.
Alt+Esc Switches to the next application window or minimized icon, 

including full-screen programs.
Alt+Tab Switches to the next application window, restoring applications 

that are running as icons.
Alt+Enter Switches a non-Windows application between running in a 

window and running full screen.
Arrow key Moves a window when you have chosen Move from the Control 

menu.
Or, changes the size of a window when you have chosen Size 
from the Control menu.






